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This guide should provide you with all the information you will need to set up your Oncampus 
Printing software and printer, as well as instructions on how to print cards and transmit the data.  
 
The Oncampus Printing software can be downloaded from the following location throughout 
the year:  
 
https://www.dropbox.com/s/febc7ieaki2m45e/FINAL%20RELEASE%20-%2017-08-2012.zip 
 
If you need to place an additional card order, you can do so via the NUS extra admin site at 
http://admin.nusextra.co.uk. Oncampus Printing card orders have a turnaround of 3 working days 
from order approval. 
 
Additional ribbons can be ordered for both the CP60 and the SD360 via NUS extra – please 
visit the link below for the order form and process: 
 
http://www.nusconnect.org.uk/resources/nusextra/Oncampus-Printing-ribbon-order-form-2012/ 
 

https://www.dropbox.com/s/febc7ieaki2m45e/FINAL%20RELEASE%20-%2017-08-2012.zip
http://admin.nusextra.co.uk/
http://www.nusconnect.org.uk/resources/nusextra/Oncampus-Printing-ribbon-order-form-2012/
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Introduction and initial checks 
 
This manual has been written based on the Datacard SD360 printer, the printer that NUS 
extra supplies for both rental and purchase. However, the NUS extra software can be used 
alongside other models of printers, including the CP60, where appropriate. 
 

1) Check system 
 

In order to offer the Oncampus Printing method to issue NUS extra cards you should have 
received includes the following items – please check that all items have been correctly delivered. 
Should there be any discrepancies, please report this immediately to NUS extra (contact details 
at the end of this document 
 

1. Datacard SD360 double sided card printer with cables, power supply and manual (see 
appendix 1 for inventory) 

2. Printer ribbon/s with cleaning cards (must be ordered separately from NUS extra) 
3. Oncampus Printing software – 2012 version 
4. Oncampus Printing user manual 2012 
5. Encoded cards – NUS extra and/or NUS extra with ISIC 

 
2) Prepare for use 

 
1. Use the Datacard set up instructions (contained in your printer box) to prepare the printer 

and your PC. 
2. Install a ribbon ready for printing. 

 

 
 
Important Note 
 
Any PC used for the issuing of Oncampus Printing cards on behalf of NUS extra should have 
adequate protection to ensure all the captured data on the PC, of the card holder’s personal 
details, is secure under the Data Protection Act.  
 
This can be ensured by using secure log in credentials, password on screen saver, physical 
locks to stop the PC being stolen, BIOS passwords and hard drive encryption. A combination of 
these methods or equivalent will help to protect the information from being used or stolen. 
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Date Confirmation 
 
When the software is first launched it will ask you whether the date that is being displayed taken 
from the PC is correct or not. If it is incorrect you will need to set the date on the PC correctly and 
restart the software. This is crucial as it will allow you to issue the new variable validity card 
successfully. 
 

 
Figure 1. Date Confirmation screen. 
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Homepage 
 

 
Figure 2. Application homepage. 
 
The software is based on Microsoft Windows format, with the standard controls at the top right of 
the window to enable resize and close of application, for example.  
 
Menu Items 

 
There are two levels of menu, the top menu strip containing ‘File’, ‘View’, ‘Settings’ and ‘Help’ 
menu options, these are shown in more detail below..  
 
On the screen you also have two buttons which handle the main functions of the application, 
‘Process Application’ and ‘Transmit Batch’.  
 
Note that at the bottom of the window a status gives the number of applications captured and 
awaiting transmission. 
 
The ‘File’ menu just provides a standard ‘Exit’ option to close the Oncampus application.  
 
The ‘View’ menu provides a function which allows the operator to see a history of batches that 
have been transmitted from that system, as well as an option to resend a batch if it has not been 
received by NUS extra. This function will be covered in more detail in the Retransmit Batch 
section of this manual (see figure 23 on page 16).  
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The ‘Help’ menu is also a typical selection as found in most Windows applications which contains 
an ‘About’ option to show information such as the version details etc.  
 
Finally there is a ‘Settings’ menu, as shown in fig 3 below, which we will go into in more detail 
here.   
 

The settings menu 
 

 
Figure 3.  The settings menu.  
 

1) Organisation Setup 
 

The ‘Organisation ID’ and ‘Organisation Name’ must be set before any applications can be 
captured. If an application is attempted without the Organisation ID being set, then a warning 
message will be displayed and the system will force the operator to enter data in the missing 
fields. 
 
Your Organisation ID is a short number that NUS uses to identify you internally. Please contact 
the NUS extra Customer Services Team if you don’t know your union’s number. 
 
The Organisation Name field has a maximum length of 35 characters (including spaces), so any 
names that are longer than this will need to abbreviated or shortened to fit.  
 

Figure 4. The Organisation Setup screen. 
The ‘Organisation Logo’ option allows each 
union to upload their own logo to be printed 
on the rear of each card. Each logo must be 
in JPG format, 189 x 106 pixels and the 
extension must be in lower case ie .jpg. 
 
If you are offering a Local Product to your 
card sales, please note that this is in addition 
to the Local Product logo.  
 
The Multi Year options will need to be set 
according to your local requirement. The 
default value will need to be set to 1 year if 
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this is the default product to be sold, if the default product is 2 or 3 year then this value will need 
changing.  
 
Note that if the ISIC option is selected the software will automatically change the expiry date to 1 
year, as the ISIC upgrade is on available on a one year card 
 
Important note: If you are offering multiyear cards through your Oncampus Printing 
issuing, you will need to offer the same option/s through your Remote sales. These 
options can be set for the Remote method through the NUS extra Admin site at 
http://admin.nusextra.co.uk.  
 
Once all the details are correct, click on the large tick in the bottom right corner to proceed and 
the following screens will appear. Check the details and select ‘yes’ and then ‘ok’ 
 

 
 

Figure 5. Organisation Details Confirmation. 
 
 

2) Printer Type Selection 
 

The Printer Type menu under the ‘Settings’ option allows the user to select the printer type 
currently being used. It is a simple task of selecting the correct printer that is to be used. A tick 
icon is displayed against the currently selected printer as shown in Fig 7. 
 

 
 Figure 7.  Printer type selection.  
 
 
 
 

Figure 6. Confirmation they have been set. 
 
 

http://admin.nusextra.co.uk/
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3) Local Products 
 

The Local Products option allows you to configure a local product. Currently this is restricted to 
one local product and it is not a mandatory requirement to have one.  
 
As the Oncampus Printing software is not designed to be consumer facing, there is no option to 
display a description as is available on the Remote option on nus.org.uk. The image that is 
added here will be printed on the reverse of the card in the second slot, alongside the union logo. 
If a new image is being uploaded to be used it must be in JPG format, 189 x 106 pixels and the 
extension must be in lower case ie .jpg. 
 
Important note: If you are offering a local product through your Oncampus Printing 
issuing, you will need to offer the same option through your Remote sales. This option 
can be set through the NUS extra Admin site at http://admin.nusextra.co.uk.  
 

 
Figure 8. Local product setup. 
 

4) Image capture mode 
 
There is the option to collect photos using either a webcam image or a photo upload, which can 
be selected here. Please note that whichever option is selected will apply to all applications 
processed, unless the change is made in this location at any time.  
 
If you choose to offer the photo upload option, please ensure that you have access to suitable 
photos on the computer/s you are using to process applications. 
 
 
 
 

http://admin.nusextra.co.uk/
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Application Process 
 
The application process is started by clicking the ‘Process Application’ button from the main 
screen. The application process contains 4 individual steps: 
 
Data Entry – Image Capture – Card print – Save Details 
 
Step 1 – Data Entry 
 
This stage is where all personal information is entered, as well as where the individual products 
can be selected. Figure 8 below shows a blank form before any data is entered. Note that a local 
product has not been imported on this example, but the option will appear under the ‘products’ 
section when applicable. The fields marked with a red asterisk are mandatory fields and an error 
message will be displayed if they are not populated.  
 

 
Figure 8.  Data entry screen. 
 
Once the data has been entered, the operator should click on the green arrow to progress to the 
next stage.  
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If at any time the operator wishes to cancel the application process, the red X at the top right can 
be used for this purpose. Additionally, upon clicking the green arrow, the application will be 
validated against certain criteria and a message will be displayed if a problem is discovered. 
These must be corrected before the operator can progress to the next stage. 
 

 
Figure 9.  Validation Errors. 
 
A note about replacement cards 
If a student needs a replacement card, this is processed in exactly the same way as a normal 
card. However, you must ensure that the ‘Mark application as a replacement?’ box is selected on 
the data entry screen, as shown in figure 8. This will trigger the finance event accordingly. 
 
A replacement card costs £5 (with ISIC remaining at £2.99). If a student has a crime reference 
number to prove a card theft, their replacement is free. To register this, send the details of the 
student along with the crime reference number to nusextra@nussl.co.uk and this will be logged 
accordingly. 
 
Step 2 – Photo Capture 
 
The photo capture stage enables the operator to take a snap shot of the applicant. Using the 
webcam, a live view is shown on screen and the operator simply needs to get the applicant in 
view before pressing a ‘Capture’ button. If you are using the photo upload method, you will be 
given the option to browse and upload a photo at this point. 
 
Once captured the screen will show a frozen image and a crop box will be visible. The crop box 
can be resized using the solid black square at the bottom right of the crop border. Note that the 
crop box will remain in the correct aspect ratio, making sure the cropped image will always be 
the correct size. 
 
If at any time the operator is not happy with the photo, they can go back to the live view and start 
again. 
 
On screen controls provide image enhancement functions such as brightness and contrast 
controls. If the operator finds themselves changing the brightness of each photo, they can 
choose ‘remember settings’ to always apply these for each crop. 

mailto:nusextra@nussl.co.uk
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Figure 10.  Photo capture screen showing the crop box  

 
Figure 11.  Cropped photo. 
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Once you are happy that the cropped image is acceptable, the green arrow can be used to 
progress. 
 
Step 3 – Print Card 
 
The print card stage will pull together the data and photo captured previously to enable a card to 
be printed. A visual of the card is shown with the various data items populated to give an 
example of the end result. Note that the card number on the image is just an example and does 
not correspond to the card you are printing. 
 
The card visual will show the NUS extra/ISIC design if that has been chosen as the card type, 
otherwise it will show as the NUS extra card. 
 
The operator is required to enter the card number (this is taken from the blank card being used) 
in to the text box and then press the print icon to begin printing. The card number is validated to 
make sure it is valid. 
 
The card in fig 12 below is showing 2 logos - the Organisation logo and the Local product logo 
(both shown here as the ‘Euclid’ logo).  
 

 
Figure 12.  The print card screen. 
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You will then be prompted to load the corresponding card in to the printer. Pressing OK will start 
the print process. Note that the correct orientation in the input hopper is, when viewed end on 
from the input end, the magnetic stripe on the card is uppermost and to the right. 
 

 
Figure 13. Begin printing. 
 
Once printing is complete, the operator must confirm whether the card has printed successfully. 
If the card has not printed, you will be given the option to print again on another card. If the card 
has printed successfully, pressing ‘yes’ to acknowledge this 
will commit the application and save it. 
 
Please note that any cards that are incorrectly printed can 
be returned to NUS extra for a full refund. Please find the 
address at the end of this document in the ‘Contact Us’ 
section 

 
Figure 14.  Printing confirmation. 

 
 
Step 4 – Save Data 
 
Once the card has been printed the application is saved, awaiting its transmission to NUS extra.  
 
A confirmation screen is shown in figure 15 below. To proceed with another application, the 
green button will loop back to the data entry screen and another application can be completed. 
However if no further applications need to be processed, the red cross can be used to end data 
capture. 

 
Figure 15. Application Complete. 
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Transmit Batch 
 
Please note: The maximum number of applications for transmission should be limited to 
less than 1000. Batches of applications should be sent on a daily basis to ensure that the 
card details can be registered, so that the student will be able to make full use of their 
card as soon as possible. 
 
The ‘Transmit Batch’ option is available from the homepage (see figure 2 on page x). This 
function batches up all captured data and transmits it to NUS extra for import into the back office 
system. 
 
Upon clicking the ‘Transmit Batch’ button, an email confirmation screen is shown. Enter a valid 
email address and an email will be generated to confirm that the sent batch has been 
successfully received and processed by NUS extra. 

 
Figure 16. Email Confirmation. 
 
When transmitting, the data is packaged together to form a single file and it is this file which is 
sent. If for whatever reason the transmission fails, this package will be stored and available to 
retry later. It is quite feasible to have a number of packages transmitted together. 
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Figure 17. Transmit Screen showing the state where no batches are waiting to be 
transmitted. 
 

 
Figure 18.Transmit batch screen showing 8 applications to be transmitted. 
 
When the operator is ready to transmit the batches, clicking on the ‘Transmit Batch’ button will 
attempt to make a connection and send the file. A progress panel is displayed whilst this is 
happening. 
 

 
Figure 19.Transmit batch –showing the progress panel. 
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Once the packages have been transmitted, the status message is updated as shown below in fig 
20. Clicking ‘ok’ will take the operator back to the home screen. 
 

 
Figure 20. Confirmation of the transmission status. 
 

 
Figure 21. Part of Main application screen – in this instance showing 0 current 
applications captured, but 1 awaiting transmission. 
 

 
Figure 22.  Part of Main application screen– showing 1 current application captured. 
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Retransmit Batches 
 
In the event that an email confirmation has not been 
received after a batch has been transmitted, (and after 
confirmation with NUS extra), you may be asked to re-
transmit that batch again. This function is accessed via the 
top menu list ‘View’ then ‘Batch History’ from the homepage. 

Figure 23. View Menu. 
 
 
NB:-This function does NOT send the batch, but adds it to the queue of unsent application 
and packages (if any) which are then sent via the normal Transmit Batch process. 
 
 
The ‘Batch History’ selection presents the operator with a list of all batches that have been 
created on that system with the option alongside each to ‘Retransmit’. 
 

 
Figure 24. Batch History Screen 
 
After selecting a batch, a message is 
displayed to confirm that the batch number 
selected is correct. 
 
If the operator confirms that this is the correct 
batch by selecting ‘OK’ a confirmation 
message will be displayed that the batch is 
ready to be retransmitted.  

Figure 25. Batch Selection 
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Figure 26. Ready to Transmit Confirmation 
 
When this process is completed the batch to be retransmitted will be displayed on the bottom of 
the screen as an unsent package.  
 

 
Figure 27. Unsent Package. 
 
To complete the Retransmit process, the batch is then sent via the normal ‘Transmit Batch’ 
function. 
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Troubleshooting Guide 
 
In all instances the operator should check that the printer is plugged in correctly, and that 
power is available 
 
Tips for success: 

 For best results, clean the printer regularly, for example after every 100 cards that are 
printed. To do this, use the run the cleaning card through the system, as provided with 
each ribbon kit. 

 If cards regularly get stuck in the printer, replace the cleaning roller and run a cleaning 
card. If the problem remains, clean the printer rollers. 

 Keep the printer lid shut at all times, both during use and especially during storage 
 
Additional set up requirement for older operating systems and printers 
 
Please note that for an initial installation of the software there may be a need to set the position 
of the protective varnish layer on the card: this is designed to protect the overprinted areas of the 
card but not areas such as the signature stripe or magstripe. This is usually only applicable to 
users running on systems prior to Windows XP with the CP60 printers or machines of an 
equivilant age. This is carried out as follows:   
 

1. Access ‘Printer Properties’ from the standard Microsoft icon 
2. Select  ‘Advanced Options’ 
3. Under  ‘Print Blocking Pattern - Front’  select ‘User defined bitmap - topcoat’. 
4. Select Ok – this will automatically copy a file to 

‘C:\cardprinter\CRDLandTopcoatFront.bmp’ each time the printer is started. 
 
 
 

Common problems 
        

1. A message appears on the PC or LCD panel.  
Try this:     
• Click the Help button on the message box to see possible causes and the solution for each 
cause.    
 

2.  Cards jam regularly.   
Try this: 
• The printer rollers might be dirty. Use cleaning card to clean the rollers 
 

3. The ribbon has broken.   
Try this: 
• Trim the end of the broken ribbon evenly. If ribbon on the take-up spool is not wound firmly or is 
uneven, remove it. Tape the end of the ribbon onto the same take-up spool, making the edges of 
the ribbon and spool even. NOTE: Do not switch take-up spools when fixing. 
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Possible Cause 1: The print ribbon is not loaded correctly. 
Solution: Load the print ribbon correctly and then close the cover. 
 
Possible Cause 2: The ribbon has been completely used. 
Solution: Use a new roll of ribbon. 
 
Possible Causes 3: The transparent wheel of the print ribbon cartridge is not in the correct 
position. 
Solution 1: Load the print ribbon cartridge with the transparent wheel in the slot. If it does not go 
in easily, it is damaged; obtain a new print ribbon  cartridge. 
Solution 2: Change the cleaning sleeve and replace the cartridge in the printer. Run a cleaning 
card as soon as printing is completed. 
 
 
Technical issues: 
 

 If you have recently changed edge-to-edge settings using the driver, printing might be too 
close to the edge of the card. Change edge to edge settings.  

 You might have moved the print ribbon while the printer power was off. The next card will 
print correctly. The printer is designed to allow you to fix problems while the printer power 
is on. 

 If the print ribbon is stuck to the card, the Intensity setting might be so high that printing 
causes the ribbon to stick to the card. Lower the Intensity or power setting. 

       
4.  The card is stuck or lost in the printer  

Open the top cover of the printer. Remove the ribbon cartridge. Locate the card inside the print 
area. The card might be stuck near the cleaning roller, the print head or at the end of the card 
track. Turn the Manual Advance Knob to move the card, (Located top left of outer printer body 
when viewed from card feeder end) If needed, grasp an end of the card and pull to remove the 
card. Replace the ribbon cartridge and close the printer cover. 
 

5. The card is lost in the duplex module  
Open the Duplex module cover (opposite end of card feeder) Release any cards stuck in the 
module. Make sure that the duplex mechanism can move freely. If the card is stuck between the 
upper and  lower duplex units, remove the card from the printer. You might see a ‘PR 01706’ 
message after removing the card. Clear the message to continue. Run a printer cleaning card, 
and then clean the printer rollers including the duplex module rollers. 
 
If you cannot fix the problem, contact NUS extra for assistance. 
 

6. The error message below appears when you take a photo… 
 

 
This is a permissions problem on the installation 
folder. This is the folder where the .exe file (i.e. the 
software) exists; the application saves the captured 
photo in it temporarily. It might be that you do not 
have permission to ‘write to’ this folder.  

Figure 28: 'Unhandled Exception' error message 
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The folder should be the installation folder, it will be similar to c:\\program files\euclid limited\on 
campus2012\. If you can get IT to set the permissions for everyone on that folder it will solve the 
error. 
 

7. When trying to transmit a batch, the following error message appears on the 
screen and the batch fails to transmit: 

 
                “The remote server returned an error: 407 Proxy Authentication Required.  
                 Exit and try again later.” 
 
This issue relates to a proxy server issue. See if your IT team can add a rule to the proxy server 
to allow access to the upload website without authentication. The address it sends to 
is:  http://admin1.nusextra.co.uk/drop/bulk-on-campus.aspx 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://admin1.nusextra.co.uk/drop/bulk-on-campus.aspx
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Contact us 
 
Should you experience any problems with the set up or operation of the system, please contact 
NUS extra via the details below and state that your call is regarding Oncampus Printing: 
 
NUS extra c/o NUS Services Ltd 
Ian King House 
Snape Road  
Macclesfield 
Cheshire 
SK10 2NZ 
 
Please use this address for any printer returns 
 
Tel:     01625 413299 
Email: nusextra@nussl.co.uk 
 
If you require more printer ribbons or would like to purchase or rent more machines, please 
contact the team on the details above and request the relevant order form. 
 
Alternatively, you can download the forms and find further information from the following location: 
 
http://www.nusconnect.org.uk/nusextra/issuing-methods/oncampus-printing/ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:nusextra@nussl.co.uk
http://www.nusconnect.org.uk/nusextra/issuing-methods/oncampus-printing/
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NUS extra: SD360 Datacard  
Appendix 1: Contents of package 
 
The contents of the SD360 Datacard card printer package from NUS extra are as follows: 
 

 Datacard SD360 Printer 

 Power Cable 

 AC Adaptor 

 USB cable 

 Cleaning Card Package 

 CD Driver 

 Instructions 

 Warranty 
 
All purchased printers will include 1 ribbon as part of the total cost, which will also be in the box 
 
For rented printers: These items must be returned with the printer in its original 
packaging as per the terms and conditions of rental, or additional costs may be incurred 
by the students’ union. 
 
 


